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PC-Fax TX Function 
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1.1 Outline of PC-FAX TX Function 

1 PC-Fax TX Function 

1.1 Outline of PC-FAX TX Function 

The general facsimile sends and receives paper documents. In contrast, the PC-Fax TX function sends a doc- 

ument data on a Windows PC as if it was printed on this machine. 

This is well suited for an environment where you handle a large number of data files because it is not neces- 

sary to prepare paper documents to send faxes. 

The fax destinations can be set using the Address Book already stored on this machine. Also, you can create 

a phone book and control the destinations on the PC. 

Tips 

The Hard Disk is optional in some areas. To use the PC-Fax TX function, the optional Hard Disk and 

Fax Kit must be installed in this machine. 

- 
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1.2 System Environment Requirements 

1.2 System Environment Requirements 

Before using the PC-Fax TX function, you must first install the fax driver software on your PC. 

If you use the installer software to install the fax driver, the machine on the network or the machine connected 

via USB interface can be detected automatically. You will be able to easily install the fax driver. 

Item Specifications 

Operating system Windows Server 2003 Standard Edition (SP1 or later) 
Windows Server 2003 Enterprise Edition (SP1 or later) 
Windows Server 2003 R2 Standard Edition 
Windows Server 2003 R2 Enterprise Edition 
Windows Server 2003, Standard x64 Edition 
Windows Server 2003, Enterprise x64 Edition 
Windows Server 2003 R2, Standard x64 Edition 
Windows Server 2003 R2, Enterprise x64 Edition 
Windows Vista Business * 

Windows Vista Enterprise * 

Windows Vista Home Basic * 

Windows Vista Home Premium * 

Windows Vista Ultimate * 

Windows Server 2008 Standard * 

Windows Server 2008 Enterprise * 
Windows Server 2008 R2 Standard 
Windows Server 2008 R2 Enterprise 
Windows 7 Home Basic 
Windows 7 Home Premium * 

Windows 7 Professional * 

Windows 7 Enterprise * 

Windows 7 Ultimate * 

Windows 8 */Windows 8.1 * 
Windows 8 Pro */Windows 8.1 Pro * 

Windows 8 Enterprise */Windows 8.1 Enterprise * 
Windows Server 2012 Datacenter 
Windows Server 2012 Standard 
Windows Server 2012 R2 Datacenter 
Windows Server 2012 R2 Standard 
* Supports 32-bit (x86)/64-bit (x64) environment. 

CPU Any processor of the same or higher specifications as recommended for your oper- 
ating system 

Memory Memory capacity as recommended for your operating system 
The memory space must be enough for the OS and applications used. 

Drive CD-ROM drive 
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1.3 Printer Cable Connection to This Machine 

1.3 Printer Cable Connection to This Machine 

The printer cables are connected to each port on this machine. 

1 

2 

 1-4 

No. Port Description 

1 
 

USB port 
 

Use a USB interface cable for USB connection. 
Use a type A (4-pin, male) to type B (4-pin, male) USB cable. A 
USB cable measuring three meters or less is recommended. 

2 
 

Ethernet port (1000Base- 
T/100Base-TX/10Base-T) 

 

Use the LAN cable to connect this machine to the network. This 
machine supports the 1000Base-T, 100Base-TX and 10Base-T 
protocols. 
The TCP/IP (LPD/LPR, IPP and SMB) protocols and Web servic- 
es are supported. 
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Preparation for PC-Fax TX 

(via Network Connection) 
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2.1 Overview 

2 Preparation for PC-Fax TX (via Network Connec- 
tion) 

2.1 Overview 

Before using the PC-Fax TX function, you must install the fax driver software on your PC. 

This section explains how to prepare PC-Fax TX, using the installer supplied with this machine. 
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2.2 Before Installing the Fax Driver (for the Administrator) 

2.2 Before Installing the Fax Driver (for the Administrator) 

Connect this machine to the network. 

 Check the LAN cable for connection. 

 Check the network settings. 

→  Ensure that this machine has an IP address assigned to it. 

Set up the PC-Fax operating environment. 

When using the Normal printing (at port 9100) 

→  Make sure that the RAW port number has been set. (Usually, you can use the default settings.) Use 

Normal Printing (Port 9100) unless otherwise specified by the administrator. 

When using the Internet Print (IPP) 

→  Check the IPP operating environment. (Usually, you can use the default settings.) 

When using the Secure Print (IPPS) 

→  Set up the IPPS operating environment. Establish the communication with SSL encryption between 

this machine and the PC. 





Preparation has finished. 

Checking the LAN cable connection 

Ensure that a LAN cable is connected to the LAN port of this machine. 

Check the network settings 

Ensure that this machine has an IP address assigned to it. Tap [Utility] - [Device Information], and check that 

an IP address is displayed. 

⊙Reference 
If no IP address is displayed, you need to set up the network. For details, refer to "User's Guide[Web Man- 

agement Tool]/[Operations Required to Use Web Connection]". 
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2.2 Before Installing the Fax Driver (for the Administrator) 

Set up the PC-Fax TX environment 

Set up the operating environment according to the method of printing. 

If the printing method is not specified before installation, Normal Printing (Port 9100) is selected for printing. 

Use Normal Printing (Port 9100) unless otherwise specified by the administrator. 

How to print Description 

Normal printing (Port 
9100) 

Make sure that the RAW port number has been set. (Usually, you can use the 
default settings.) 
The settings configuration method is explained using Web Connection. For 
details, refer to "User's Guide[Web Management Tool]/[Configuring the Print- 
ing Environment]". 

Internet Print (IPP) Check the IPP operating environment. (Usually, you can use the default set- 
tings.) 
The settings configuration method is explained using Web Connection. For 
details, refer to "User's Guide[Web Management Tool]/[Configuring the Print- 
ing Environment]". 

Secure Print (IPPS) Set up the IPPS operating environment. Establish the communication with SSL 
encryption between this machine and the PC. 
The settings configuration method is explained using Web Connection. For 
details, refer to "User's Guide[Web Management Tool]/[Configuring the Print- 
ing Environment]". 

Tips 

In Windows Vista/7/8/8.1/Server 2008/Server 2008 R2/Server 2012/Server 2012 R2, you cannot set up 

the Secure Print (IPPS) using the installer. 

If you are using Windows Server 2003 in an IPv6 environment, you cannot setup this machine using the 

installer. 

The Internet Print (IPP) is not supported in the IPv6 environment. 

- 

- 

- 

Enabling device information to be obtained from the fax driver 

Disable the OpenAPI authentication function. (Usually, you can use the default settings.) 

If device information collection from the fax driver is enabled, the fax driver automatically collects the infor- 

mation such as optional device attachment and authentication settings. 

For details on how to configure the settings, refer to "User's Guide[Descriptions of Functions/Utility 

Keys]/[Utility]". 

Related setting (for the administrator) 
You can use a password to restrict the ability to obtain device information from the printer driver (de- 

fault: [No]). For details, refer to "User's Guide[Descriptions of Functions/Utility Keys]/[Utility]". 

- 
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2.3 Quick Installation of the Fax Driver 

2.3 Quick Installation of the Fax Driver 

Prepare the fax driver. 

 Prepare the fax driver CD-ROM disk. 

→  Contact this machine administrator for the CD-ROM disk. 

 Check the operating system (OS) version that supports the fax driver. 

→  Ensure that the operation requirements of the fax driver are satisfied by the PC where you install the 

fax driver. 

Install the fax driver on the PC. 

 Install the fax driver on the PC using the installer. 

→  Insert the Driver & Utilities CD-ROM Vol.1 disk into the drive, and install the software by following 

the on-screen instructions. 

 Carry out a test print. 

→  Carry out a test print and verify that it is acceptable. 

Preparation has finished. 

Prepare the fax driver CD-ROM disk. 

The following driver installation CD-ROM disks are delivered with this machine. The fax driver is included in 

the Driver & Utilities CD-ROM Vol.1. 

CD-ROM disks delivered Description 

Driver & Utilities CD-ROM Vol.1 Contains the printer driver (PCL/PS/FAX) for Windows and 
screen fonts. This also contains the page for downloading util- 
ity software. 

Driver & Utilities CD-ROM Vol.2 Contains the printer driver (XPS) for Windows, printer driver for 
the Mac OS, screen fonts, and TWAIN driver. This also con- 
tains the page for downloading utility software. 

User's Guide CD-ROM Contains the User's Guide. 

Tips 

In User's Guide manuals, location paths of folders or files may not contain the root directory. 

To install the fax driver manually, specify the driver files in the EN (English) folder, and nothing else- 

where. 

- 

- 

Check the operating system (OS) version that supports the fax driver 

For details on the PC's Operating System (OS) that supports the fax driver, refer to page 1-3. 

Installation procedure 

Install the fax driver on the PC by using the installer. 

◎ 
 
◎ 

1 

You need to have the administrator privileges to perform this task. 

Use the Driver & Utilities CD-ROM Vol.1. 

Insert the fax driver CD-ROM into the CD-ROM drive of the PC. 

→ 

→ 

Make sure that the installer starts, and then go to Step 2. 

If the installer does not start, open the printer driver folder on the CD-ROM, double-click [Set- 

up.exe], and then go to Step 3. 

If the [User Account Control] window appears, click [Continue] or [Yes]. → 

2 Click [Printer Install]. 
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2.3 Quick Installation of the Fax Driver 

3 

4 

Read the license agreement, then click [AGREE]. 

Select [Install printers/MFPs], then click [Next]. 

Connected printers are detected. 

→  In Windows Vista/7/8/8.1/Server 2008/Server 2008 R2/Server 2012/Server 2012 R2, you can select 

[Preference for IPv4] or [Preference for IPv6]. The address has the preference when detected in both 

IPv4 and IPv6. 

5 Select this machine, then click [Next]. 

→ 

→ 

If this machine is not detected, restart it. 

You do not need to change the printing method from [Normal Printing] (Port 9100) unless otherwise 

specified by the administrator. 

As a printing method, you can select [Normal Printing], [Internet Printing] (IPP), or [Secure Printing] 

(IPPS). 

Among the connected printers, only the target model is automatically detected and displayed. If 

multiple target models are displayed, check the IP addresses. 

You can check the IP address of this machine in the screen that is displayed by tapping [Utility] - 

[Device Information]. 

If the connection to this machine cannot be recognized, it is not displayed in the list. In such a case, 

select [Specify the Printer/MFP Except for the Above. (IP Address, Host Name...)], and manually 

specify the IP address and host name of this machine. 

→ 

→ 

→ 

6 

7 

8 

Select the fax driver box, then click [Next]. 

Check the items to be installed, then click [Install]. 

Change the printer name or print a test page if necessary, then click [Finish]. 

The fax driver has been installed on the PC. 

Settings Description 

[Review] Displays the installed components for checking. 

[Rename Printer] Changes this machine name if necessary. 

[Property] Sets the optional operating environment of this machine. For details, refer to 
page 2-7. 

[Print Setting] Changes the default print settings of this machine if necessary. For details, re- 
fer to page 2-7. 

[Print Test page] Prints a test page to check the normal data transfer if necessary. 

⊙Reference 
Be sure to initialize the fax driver after you have installed it. For details, refer to page 2-7. 
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2.4 Initialize the Fax Driver 

2.4 Initialize the Fax Driver 

Configuring the optional environment of this machine 

If you are using this machine for the first time, ensure that optional device installation and authentication set- 

tings have been correctly reflected on the fax driver. 

1 Open the [Properties] screen of the fax driver.. 

→  For details on how to open the [Properties] screen, refer to page 6-2. 

2 Open the [Configure] tab, and check the optional device installation and authentication settings on this 

machine. 

→ Because the [Auto] of [Obtain Settings...] by default, the current information of this machine is ob- 

tained automatically and reflected on the [Device Option]. 

If the [Auto] of [Obtain Settings...] is disabled and if you click [Obtain Device Information], the current 

information of this machine is obtained and reflected on the [Device Option]. 

If communication with this machine fails, set the [Device Option] manually. Select an item to change 

from the list, and set a value in the [Setting]. 

→ 

→ 

3 Click [OK]. 

Change the default print settings 

You can change the default print settings of the fax driver if necessary. 

For example, if you set to send the initial value with page combination, you can reduce the number of pages 

printed at the destination. We recommend that you change the default settings to suit your environment. 

1 Open the [Printing Preferences] screen of the fax driver. 

→  For details on how to open the [Printing Preferences] screen, refer to page 6-11. 
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2.4 Initialize the Fax Driver 

2 Change the print settings, then click [OK]. 

Your changes apply to the PC-Fax TX in all application software. 

⊙Reference 
The fax driver has the function to save favorite settings. For details, refer to page 4-10. 

 2-8 

2  

 

 



Preparation for PC-Fax TX 

(via USB Connection) 
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3.1 Overview 

3 Preparation for PC-Fax TX (via USB Connection) 

3.1 Overview 

Before using the PC-Fax TX function, you must install the fax driver software on your PC. 

This section explains how to prepare PC-Fax TX, using the installer supplied with this machine. 
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3.2 Quick Installation of the Fax Driver 

3.2 Quick Installation of the Fax Driver 

Prepare the fax driver. 

 Prepare the fax driver CD-ROM disk. 

→  Contact this machine administrator for the CD-ROM disk. 

 Check the operating system (OS) version that supports the fax driver. 

→  Ensure that the operation requirements of the printer driver are satisfied by the PC where you install 

the fax driver. 

Install the fax driver on the PC. 

Set up the software installation on the PC. 

→  In Windows 7/8/8.1/Server 2008 R2/Server 2012/Server 2012 R2, you need to change the PC set- 

tings in advance. 

Install the fax driver on the PC using the installer. 

→  After connecting the USB cable, insert the Driver & Utilities CD-ROM Vol.1 disk into the drive, and 

install the software by following the on-screen instructions. 

Carry out a test print. 

→  Carry out a test print and verify that it is acceptable. 





Preparation has finished. 

Prepare the fax driver CD-ROM disk 

The following driver installation CD-ROM disks are delivered with this machine. The fax driver is included in 

the Driver & Utilities CD-ROM Vol.1. 

CD-ROM disks delivered Description 

Driver & Utilities CD-ROM Vol.1 Contains the printer driver (PCL/PS/FAX) for Windows and 
screen fonts. This also contains the page for downloading util- 
ity software. 

Driver & Utilities CD-ROM Vol.2 Contains the printer driver (XPS) for Windows, printer driver for 
the Mac OS, screen fonts, and TWAIN driver. This also con- 
tains the page for downloading utility software. 

User's Guide CD-ROM Contains the User's Guide. 

Tips 

In User's Guide manuals, location paths of folders or files may not contain the root directory. 

To install the fax driver manually, specify the driver files in the EN (English) folder, and nothing else- 

where. 

- 

- 

Check the operating system (OS) version that supports the fax driver 

For details on the PC's Operating System (OS) that supports the fax driver, refer to page 1-3. 

Changing the installation settings (Windows 7/8/8.1/Server 2008 R2/Server 
2012/Server 2012 R2) 

If the PC is running on Windows 7/8/8.1/Server 2008 R2/Server 2012/Server 2012 R2, change the current PC 

settings before installing the fax driver. 
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3.2 Quick Installation of the Fax Driver 

1 Open the [Control Panel] window. 

→ 

→ 

→ 

→ 

In Windows 8.1, click [ ]in the Start window, then click [Control Panel]. 

In Windows 8, right-click the Start window, then click [All apps] - [Control Panel].  

In Windows Server 2012/Server 2012 R2, click [Control Panel] in the Start window. 

In Windows 7/Server 2008 R2, open the Start menu, then click [Control Panel]. 

2 

3 

Click [System and Security] - [System]. 

Click [Advanced system settings] on the menu to the left. 

The [System Properties] screen appears. 

4 In the [Hardware] tab, click [Device Installation Settings]. 

5 Select [No, let me choose what to do], select [Never install driver software from Windows Update.], then 

click [Save Changes]. 

→  When you have finished installing the fax driver, change the setting back to [Yes, do this automati- 

cally (recommended)]. 

6 Click [OK] to close the [System Properties] screen. 

Installation procedure 

Install the fax driver on the PC by using the installer. 

◎ You need to have the administrator privileges to perform this task. 

Use the Driver & Utilities CD-ROM Vol.1. 
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3.2 Quick Installation of the Fax Driver 

1 Connect a USB cable to the USB port of this machine. 

→  If a wizard screen appears to add new hardware, click [Cancel]. 

2 Insert the fax driver CD-ROM into the CD-ROM drive of the PC. 

→ 

→ 

Ensure that the installer starts, then go to Step 3. 

If the installer does not start, open the printer driver folder on the CD-ROM, double-click [Set- 

up.exe], then go to Step 4. 

If the [User Account Control] window appears, click [Continue] or [Yes]. → 

3 

4 

5 

Click [Printer Install]. 

Read the license agreement, then click [AGREE]. 

Select [Install printers/MFPs], then click [Next]. 

Printers being connected via USB ports are detected. 

6 Select this machine, then click [Next]. 

7 

8 

9 

Select the fax driver box, then click [Next]. 

Check the items to be installed, then click [Install]. 

Change the printer name or print a test page if necessary, then click [Finish]. 

The fax driver has been installed on the PC. 

Settings Description 

[Review] Displays the installed components for checking. 

[Rename Printer] Changes this machine name if necessary. 

[Property] Sets the optional operating environment of this machine. For details, refer to 
page 3-7. 

[Print Setting] Changes the default print settings of this machine if necessary. For details, re- 
fer to page 3-7. 
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3.2 Quick Installation of the Fax Driver 

Settings Description 

[Print Test page] Prints a test page to check the normal data transfer if necessary. 

⊙Reference 
Be sure to initialize the fax driver after you have installed it. For details, refer to page 3-7. 
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3.3 Initialize the Fax Driver 

3.3 Initialize the Fax Driver 

Configuring the optional environment of this machine 

If you are using this machine for the first time, apply the optional device installation and authentication set- 

tings to the fax driver. 

1 Open the [Properties] screen of the fax driver. 

→  For details on how to open the [Properties] screen, refer to page 6-2. 

2 Open the [Configure] tab, and check the optional device installation and authentication settings on this 

machine. 

→  In Windows Vista/7/8/8.1/Server 2008/Server 2008 R2/Server 2012/Server 2012 R2,[Auto] in [Ob- 

tain Settings...] is enabled by default. Thus, the information on this machine is automatically ob- 

tained and reflected in [Device Option]. 

If the [Auto] in [Obtain Settings...] is disabled, clicking [Obtain Device Information], the current infor- 

mation of this machine is obtained and reflected on [Device Option]. 

→  In Windows Server 2003, manually configure settings in [Device Option]. Select an item to change 

from the list, and set a value in the [Setting]. 

3 Click [OK]. 

Change the default print settings 

You can change the default print settings of the fax driver if necessary. 

For example, if you set to send the initial value with page combination, you can reduce the number of pages 

printed at the destination. We recommend that you change the default settings to suit your environment. 

1 Open the [Printing Preferences] screen of the fax driver. 

→  For details on how to open the [Printing Preferences] screen, refer to page 6-11. 
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3.3 Initialize the Fax Driver 

2 Change the print settings, then click [OK]. 

All the changes you made will be applied when executing PC-Fax TX using any type of application soft- 

ware. 

⊙Reference 
The fax driver has the function to save favorite settings. For details, refer to page 4-10. 
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PC-Fax TX Operations 
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4.1 Transmission Flow 

4 PC-Fax TX Operations 

4.1 Transmission Flow 

1 

2 

Open document data using the application software. From the [File] menu, select [Print]. 

Check that the fax driver of this machine is selected in [Printer Name] (or [Select Printer]). 

→  The [Print] dialog box differs depending on the application. 

3 

4 

Set a range of pages to send. 

Click the [Properties] (or [Preferences]) and change the print settings of fax driver if necessary. 

→ 

→ 

For details on the print settings, refer to page 6-2. 

The print settings you have changed here return to the default values when you exit the application 

software. For details how to change the default print settings, refer to page 2-7. 

The fax driver provides Favorite Setting to enable quick selection of frequently used print settings. 

For details, refer to page 4-10. 

→ 

5 Click [Print]. 

The [FAX Transmission Popup] screen opens. 
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4.1 Transmission Flow 

6 Set the recipient name and fax number. 

→ When you select a recipient from the Address Book of this machine, click [Add from Address 

Book...]. For details, refer to page 4-6. 

When you select a recipient from the Phone Book of the PC, click [Add From Phone Book...]. For 

details, refer to page 4-5. 

Set the fax transmission function and add a cover page to the fax if necessary. For details, refer to 

page 4-8. 

→ 

→ 

7 Click [Add Recipients]. 

→  When you send a fax to multiple destinations, repeat Steps 6 and 7. You can register up to 100 re- 

cipients. 

→  To cancel a recipient, select it, then click [Delete From List]. 

8 Click [OK]. 

The document data are faxed via the machine. 
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4.2 The [FAX Transmission Popup] Screen 

4.2 The [FAX Transmission Popup] Screen 

4.2.1 Opening the [FAX Transmission Popup] Screen 

From the [FAX Transmission Popup] screen, you can select fax recipients and change the fax transmission 

conditions. You can open the [FAX Transmission Popup] screen as follows: 

1 

2 

Open document data using the application software. From the [File] menu, select [Print]. 

Check that the fax driver of this machine is selected in [Printer Name] (or [Select Printer]). 

→  The [Print] dialog box differs depending on the application. 

3 Click [Print]. 

The [FAX Transmission Popup] screen opens. 

4.2.2 The [FAX Transmission Popup] Screen Options 

Settings Description 

[Name] Enter a recipient name (using up to 80 characters). 

[FAX Number] Enter the destination fax number (using up to 38 digits, with available symbols 
being a hyphen (-), #, *, P, and T). 
When you send a fax to a foreign country, enter the country code before the 
fax number. 
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4.2 The [FAX Transmission Popup] Screen 

Settings Description 

[ECM] Uncheck the ECM box to cancel the Error Correction Mode (ECM). 
The ECM is an error correction mode defined by the ITU-T (International Tele- 
communication Union - Telecommunication Standardization Sector). If fax ma- 
chines support the ECM, they check for fax data errors while communicating 
with each other. Image disturbances due to telephone line noise can be sup- 
pressed. 
This machine uses the ECM based communication by default. However, if the 
noise is high, the communication may take a little longer than the communica- 
tion without using ECM checking. 
If you need to shorten the communication time, cancel the ECM checking and 
send a fax. However, an image error or communication error may occur de- 
pending on the specified communication time value, so change the value to 
suit conditions. 

[International Transmis- 
sion Mode] 

Select the [International Transmission Mode] check box to send a fax to a for- 
eign country. 
The Overseas TX Mode function reduces the transmission speed (the informa- 
tion transfer speed) for sending a fax. This is useful when sending a fax to an 
area where the communication status is poor. 

[V.34 Mode] Clear the [V.34 Mode] check box to release the V.34 protocol mode. 
The V.34 protocol is used for Super G3 fax communication. This can shorten 
the communication time and cut the communication cost because a single 
page of size-A4 document can be sent within approximately 3 seconds. 
This machine uses the V.34 protocol communication by default. This machine 
cannot use the Super G3 mode communication if this machine or the destina- 
tion fax is not connected to the PBX line or if the fax line speed is limited. If so, 
cancel the V.34 mode communication. 

[Add Recipients] When a recipient is entered in the [Recipients Entry] field, this button adds it to 
the [Recipient List] list. 

[Add from Address 
Book...] 

Click this button to select a recipient from the Address Book of this machine. 
For details, refer to page 4-6. 

[Add From Phone 
Book...] 

Click this button to select a recipient from the Phone Book of the PC. For de- 
tails, refer to page 4-5. 

[Register To Phone 
Book] 

Click this button to register the [Name] and [FAX Number] in the Phone Book. 
This entry is stored in the [Simple Entry] folder of the Phone Book. For details 
on how to register, refer to page 4-12. 

[Fax Mode Setting De- 
tails...] 

Click this button to set the fax TX functions such as timer transmission and F- 
code transmission. For details, refer to page 4-8. 

[FAX Cover Sheet] Select this check box to add a cover sheet to the fax when you send it. Click 
the [Settings] button to set up the cover sheet details. For details, refer to 
page 5-2. 

4.2.3 Select a Recipient from the Phone Book 

You can quickly select a PC-Fax recipient from the Phone Book being controlled on your PC. 

◎ The recipient registration is required in advance. For details on how to register it, refer to page 4-12. 

1 From the [FAX Transmission Popup] screen, select [Add From Phone Book...]. 
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4.2 The [FAX Transmission Popup] Screen 

2 Select [Personal List] or [Group] from the list on the left side of the Phone Book, and display the desired 

recipient in the [Personal Information] list. 

→  When you click [Search...], you can use a conditional search. The search results are displayed in the 

[Personal Information] list. For details, refer to page 4-13. 

3 Select a recipient name from the [Personal Information] list, then click [Add Recipients]. 

→ 

→ 

→ 

You can register up to 100 recipients. 

To cancel a recipient, select it, then click [Delete]. 

If the recipient is already registered in a Group, select the group name, then click [Add Recipients]. 

All members are added to the [Recipient List]. 

4 Click [OK]. 

The screen returns to the [FAX Transmission Popup] screen. 

4.2.4 Select a Recipient from the Address Book of This Machine 

Select a PC-Fax recipient from the Address Book stored on this machine. 

◎ You can use the PC-Fax transmission only when this machine can communicate with the PC through 

the network. 

The recipient must be registered in the Address Book in advance. For details on how to register it, refer 

to "User's Guide[Fax Operations]/[Managing Destinations]". 

◎ 

1 From the [FAX Transmission Popup] screen, select [Add from Address Book...]. 
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4.2 The [FAX Transmission Popup] Screen 

2 Select [Address Book List] from the list at the left of screen, and display the desired recipient in the [Ad- 

dress Book] list. 

→  Click the [Get Addr. Info] button, and this machine starts communication and obtains the recipient 

information. 

→  When you click [Search...], you can use a conditional search. The search results are displayed in the 

[Address Book] list. 

3 Select the recipient from the [Address Book] list, then click [Add Recipients]. 

→  You can register up to 100 recipients. 

→  To cancel a recipient, select it, then click [Delete From List]. 

4 Click [OK]. 

The screen returns to the [FAX Transmission Popup] screen. 

4.2.5 Search for a Recipient from LDAP Server 

If you are using the LDAP server or the Active Directory of Windows Server, you can search for a recipient on 

the server. 

◎ The LDAP server must be registered in advance to enable recipient search from the server. For details 

on how to register, refer to page 6-9. 

1 From the [FAX Transmission Popup] screen, select [Add From Phone Book...]. 
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4.2 The [FAX Transmission Popup] Screen 

2 Select the LDAP server for search from the left list, then click [Search]. 

3 Set the search conditions in the [Basic] tab or [Advanced] tab, then click [Search Now]. 

→  The [Basic] search displays recipients which meet any of search conditions. Enter characters to 

search, then click [Search Now]. 

→  The [Advanced] search displays the recipient which matches all of search conditions. Select the 

[Search Item] and [Condition]. Then, enter characters to search, then click [Add Condition]. Specify 

multiple search conditions if necessary, then click [Search Now]. 

The search result is displayed. 

4 Select the recipient from the search result, and add it to the Recipients list. 

4.2.6 Set the Fax Transmission Functions 

From the [FAX Transmission Popup] screen, select [Fax Mode Setting Details...] and you can set up the Fax 

transmission functions. 

Settings Description 

[Print Recipient File] Select this check box to send a fax and print it at the same time. 
You can also set this option using the [FAX] tab of the [Printing Preferences] 
screen. 

[Timer Send] Select this check box to set a time to send a fax. The fax is automatically sent 
at the specified time. 
• [Reflect Current Time]: Reflects the current time of the PC onto the [Send 

Time]. 
You can also set this option using the [FAX] tab of the [Printing Preferences] 
screen. 

[SUB Address] When you use the F-code TX function, select this box and enter the destination 
box number (using up to 20 digits). 
You can also set this option using the [FAX] tab of the [Printing Preferences] 
screen. 
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4.2 The [FAX Transmission Popup] Screen 

Settings Description 

[Sender ID] When you use the F-code TX function, select this box and enter the password 
for the destination box (using up to 20 digits, with available symbols being # 
and *). 
You can also set this option using the [FAX] tab of the [Printing Preferences] 
screen. 

Tips 

When you use the timer transmission, check that the clock time of the PC matches the clock time of 

this machine. If the clock time of this machine has already passed the specified send time, the fax is 

sent in the next day. 

- 

4.2.7 Add a Cover Sheet 

When you open the [FAX Transmission Popup] screen and select the [FAX Cover Sheet], you can add a cover 

sheet to the fax to be sent. 

When you click [Settings...], you can change the cover sheet. For details on how to change it, refer to 

page 5-2. 
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4.3 Call the Frequently Used Settings 

4.3 Call the Frequently Used Settings 

You can register the current print settings as a favorite and recall it when executing sending. 

When you register a frequently used combination of print settings as a favorite, you can easily apply all of 

those settings just by selecting the combination from the Favorite Setting list, even if the combination is com- 

plicated as it contains settings on multiple tabs. 

The following explains the procedure of favorite print setting. 

1 

2 

In the [Printing Preferences] window, set the print conditions you want to register as a favorite. 

Click [Add...]. 

→  When you edit an existing setting, select its name from the [Favorite Setting] , then click [Edit]. 

3 Enter the name of the favorite to be registered. 

→  Set an icon, a comment and call options for the favorite settings if necessary. 

Settings Description 

[Name] Enter the name of the favorite to be registered. 
Use a name that helps you easily identify the favorite. 

[Icon] Assign an icon to the favorite settings if necessary. 

[Sharing] Select this check box when you want to share the favorite with other users. 

[Comment] Enter a comment to the favorite settings if necessary. 
The comment is displayed when you place the mouse cursor over the favorite 
on the Favorite Setting list. 

[Restore Items] The favorite settings may contain the size of original and other options which 
are determined only when fax is sent. When you call the favorite settings, these 
options are not set by default. However, you can define these options in the 
favorite settings if necessary. 
Select the check box of items to be retrieved. 
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4.3 Call the Frequently Used Settings 

4 Click [OK]. 

The print settings are registered as a favorite. You can select the favorite settings from the [Favorite 

Setting] list when sending the fax. 
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4.4 Managing the Recipient Information by the PC (Using the Phone Book) 

4.4 Managing the Recipient Information by the PC (Using the Phone 
Book) 

Register recipients in the Phone Book 

If you have registered the frequently calling recipients in the Phone Book, you can quickly call the recipient 

when sending a fax. Use the [FAX] tab of the fax driver to add recipients to a phone book. 

When you use the Phone Book for the first time, create a Phone Book file. When you use the Phone Book for 

the second or other times, the previously used Phone Book file is opened automatically. When you change 

the contents of Phone Book, the Phone Book file is overwritten with your changes. 

1 In the [FAX] tab, click [Phone Book Entry...]. 

2 Select [Personal List] from the list at left, then click [Add New...]. 

3 Enter the recipient information. 

Settings Description 

[Name] Enter a recipient name (using up to 80 characters). 
When you set the recipient name, you can add a title to this name. 

[FAX Number] Enter the destination fax number (using up to 38 digits, with available symbols 
being a hyphen (-), #, *, P, and T). 
When you send a fax to a foreign country, enter the country code before the 
fax number. 

[Company Name] Enter the company name of the recipient if necessary (using up to 80 charac- 
ters). 

[Department] Enter the organization name of the recipient if necessary (using up to 80 char- 
acters). 
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4.4 Managing the Recipient Information by the PC (Using the Phone Book) 

Settings Description 

[ECM] Uncheck the ECM box to cancel the Error Correction Mode (ECM). 
The ECM is an error correction mode defined by the ITU-T (International Tele- 
communication Union - Telecommunication Standardization Sector). If fax ma- 
chines support the ECM, they check for fax data errors while communicating 
with each other. Image disturbances due to telephone line noise can be sup- 
pressed. 
This machine uses the ECM based communication by default. However, if the 
noise is high, the communication may take a little longer than the communica- 
tion without using ECM checking. 
If you need to shorten the communication time, cancel the ECM checking and 
send a fax. However, an image error or communication error may occur de- 
pending on the specified communication time value, so change the value to 
suit conditions. 

[International Transmis- 
sion Mode] 

Select the [International Transmission Mode] check box to send a fax to a for- 
eign country. 
The Overseas TX Mode function reduces the transmission speed (the informa- 
tion transfer speed) for sending a fax. This is useful when sending a fax to an 
area where the communication status is poor. 

[V.34 Mode] Clear the [V.34 Mode] check box to release the V.34 protocol mode. 
The V.34 protocol is used for Super G3 fax communication. This can shorten 
the communication time and cut the communication cost because a single 
page of size-A4 document can be sent within approximately 3 seconds. 
This machine uses the V.34 protocol communication by default. This machine 
cannot use the Super G3 mode communication if this machine or the destina- 
tion fax is not connected to the PBX line or if the fax line speed is limited. If so, 
cancel the V.34 mode communication. 

[Select Group] When you add a recipient to the group, select this group check box. You can 
also add a recipient in multiple groups. 
Once added, you can specify recipients by selecting their group (for broad- 
casting). If you send faxes frequently to particular members, it will be useful to 
add them to a group. 

4 Click [OK]. 

The personal information is registered and displayed under [\\Phone Book\Personal List]. If you have 

selected groups for the recipient, it will be displayed in the groups list. 

5 Click [OK]. 

The Phone Book is finished from editing. When you are creating a Phone Book, go to Step 6. 

6 

7 

Click [Yes]. 

Specify the storage location, enter the file name, then click [Save]. 

→  The [Save As] screen is opened when you save the Phone Book for the first time. When you change 

the Phone Book for the second or other times, the [Save As] screen is not opened but the Phone 

Book file is overwritten with your changes automatically. 

The Phone Book is saved as a file (in CSV format). 

Tips 

The saved Phone Book file automatically appears when you open the Phone Book next time. To open 

another Phone Book file, open the [Phone Book Entry] screen, and select [Open...] from the [File] menu. 

Saving multiple Phone Book files can switch between these files to locate the desired one. 

When you create a Phone Book file, open the [Phone Book Entry] screen and select [New] from the [File] 

menu. Also, you can save the file to have an alias by selecting [Save As...] from the [File] menu. 

- 

- 

Search for destination 

You can search for a recipient from the Recipients List registered in the Phone Book. 

Part of recipient information or multiple conditions can be used for this search. 
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4.4 Managing the Recipient Information by the PC (Using the Phone Book) 

When you search for a recipient, click [Search...] from the Phone Book. Your operations are the same when 

you open the Phone Book to send a fax and when you open the Phone Book to add a recipient to it. 

You can use the [Basic] search or [Advanced] search. 

The [Basic] search displays recipients which meet any of search conditions. Enter characters to search, then 

click [Search Now]. 

The [Advanced] search displays the recipient which matches all of search conditions. Select the [Search Item] 

and [Condition]. Then, enter characters to search, then click [Add Condition]. Specify multiple search condi- 

tions if necessary, then click [Search Now]. 

Edit the recipient information 

You can have an easy to use Phone Book by customizing it. You can edit the recipient information, and edit 

and file the Phone Book. When you edit the Phone Book, use the Phone Book that you open when adding a 

recipient. 

- 

- 

When you edit the recipient information, select a recipient from the [Personal List], then click [Edit...]. 

To delete a recipient from the Phone Book, select the recipient from the [Personal List], then click [De- 

lete]. During this time, the recipient is also deleted from the registered group. 

Tips 

If you directly enter a recipient name and fax number when sending a fax and if you register them by 

the [Register To Phone Book], the name and fax number are displayed in the [Simple Entry] folder. 

- 
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4.4 Managing the Recipient Information by the PC (Using the Phone Book) 

Change the recipient group 

When you change a group, use the Phone Book that you open when adding a recipient. 

From the [Personal List], select a recipient that you wish to move to another group, and select the check box 

of the desired group number shown at the right of the screen. 

Tips 

You can also register a recipient by dragging the name from the [Personal List] to a group. However, 

you cannot delete the recipient from the group by dragging the name. 

You can register up to 100 recipients to one group. 

- 

- 

Changing a group name 

From the [Group] list on the left-hand side of the Phone Book, select a group you wish to rename and select 

[Rename Group...] from the [Edit] menu. Rename the group in the displayed screen. 

Control the recipients using folders 

You can control the recipients compositely by combining a folder and a group. 

Select [Personal List], then click [Add Folder...] to create a folder. You can also select [Add Folder...] in the 

[Edit] menu to create a folder. 

- 

- 

- 

You can move a recipient name from the [Personal List] to another folder by dragging it. 

To rename a folder, select it, then click [Edit...]. 

To delete a folder, select it, then click [Delete]. 

Tips 

You can also move a recipient to another folder by selecting the [Copy] or [Cut] from the shortcut menu, 

and by selecting [Paste] to the desired folder. 

You can enter a folder name using up to 40 characters. 

You can create folders up to three hierarchy levels. 

- 

- 

- 
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4.4 Managing the Recipient Information by the PC (Using the Phone Book) 
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5.1 Send a Fax with a Cover Sheet 

5 Sending Options 

5.1 Send a Fax with a Cover Sheet 

When you open the [FAX Transmission Popup] screen and select the [FAX Cover Sheet] check box, you can 

add a cover sheet to the fax when sending. 

Tips 

You can edit the cover sheet data in the [FAX Cover Sheet Settings] screen, which is opened when you 

click [Settings...]. Also, you can set it in the [FAX] tab of the fax driver. 

- 

1 

2 

Open the [FAX Transmission Popup] screen, and select the [FAX Cover Sheet] check box. 

Click [Settings...]. 

The [FAX Cover Sheet Settings] screen opens. 

3 Select a size of cover sheet from the [Cover Size]. 

4 Set a style and subject of the cover sheet in the [Basic] tab. 

Settings Description 

[Style] Select a style of cover sheet. 

[Subject] When you write a subject on the cover sheet, select this check box and enter 
the subject (using up to 64 characters). 

[Date] When you write the date on the cover sheet, select this check box and specify 
the date format. 
• 
• 

[Select Form]: Select a format of date. 
[Input Arbitrarily]: Enter a format of date (using up to 20 characters). 
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5.1 Send a Fax with a Cover Sheet 

Settings Description 

[Pages] When you write the total number of fax pages on the cover sheet, select this 
check box and select a number of fax pages including the cover sheet. 

[Comment] When you send a comment to the destination, enter it using up to 640 charac- 
ters. (A New Line code is considered to be two characters long.) 

5 Open the [Recipient] tab, and select the [Standard] or [Details] format of destination. 
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Settings Description 

[Standard] 
 

Use the standard characters to write the standard character string, which does 
not specify the recipient, on the cover sheet. 

[Details] 
 

When you write the recipient information on the cover sheet, set a style. 
To add a title to the recipient, add it when you set the recipient name in the [FAX 
Transmission Popup] screen. 

 [Load 
with Joint 
Name] 

Enter the joint name of recipients which has been added to the [Recipient List] 
of [FAX Transmission Popup] screen. 

 

[Change 
Each Re- 
cipient] 

 

This option changes the information written on the cover sheet for each recipi- 
ent. Enter the contents of [Recipient List] displayed in the [FAX Transmission 
Popup] screen. 
You can create different cover sheets for up to 100 recipients. 

[Load Set 
Informa- 
tion] 

 

Enter the information you have set in the [Company Name], [Department], 
[Name], and [FAX Number] fields (using up to 80 characters for each entry). 
You can select this option if a recipient has been added to the [Recipient List] 
of [FAX Transmission Popup] screen. 
• When you click [Read], information of the first line of [Recipient List] of the 

[FAX Transmission Popup] screen is reflected. 
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5.1 Send a Fax with a Cover Sheet 

6 Enter the sender information in the [Sender] tab (using up to 80 characters for each entry). 

7 To add an image, specify an image file in the [Image] tab. 

→ You can place images such as company's logo and map on the cover sheet. BMP format can be 

specified. 

Select the [Zoom] check box to zoom an image. 

Set a position to add an image, using [X:] and [Y:] options. 

→ 

→ 

8 Check the layout image of cover sheet. 

→  Click [Check...] to enlarge and check the layout image. 

→  When you click [Add...], the cover sheet image is saved and you can recall it later by selecting [Cover 

Sheet Settings]. 

9 Click [OK]. 
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5.2 Sending a Fax at Preset Time (Timer TX) 

5.2 Sending a Fax at Preset Time (Timer TX) 

Timer transmission 

The Timer TX function can send a fax at the preset time if you have set a time in advance. 

If you use the timer transmission during telephone rate discount time in early morning or late at night, you can 

cut the communication cost. You can send up to 20 faxes by timer transmission. 

Tips 

When sending a fax using a timer, make sure that the time set in the computer matches that set in this 

machine. If the current time has already passed the Timer TX time, the fax is sent in the next day. 

- 

How to send 

1 From the [FAX Transmission Popup] screen, select [Fax Mode Setting Details...]. 

The [Fax Mode Details] screen opens. 

2 Select the [Timer Send] check box, and set the [Send Time]. 

→  When you click [Reflect Current Time], the current clock time of the PC is reflected on the [Send 

Time]. 

3 Click [OK]. 
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5.3 Sending a Confidential Fax (Confidential Communication) 

5.3 Sending a Confidential Fax (Confidential Communication) 

Confidential communication 

The confidential communication function is designed for communications with specific people using a Con- 

fidential User Box that requires a registered number and a password. 

This ensures fax communications are sent with enhanced security. 

Tips 

The destination fax needs to have the F-code function. 

When sending a confidential fax, you need to check the recipient's Confidential User Box number and 

the password for confidential fax reception. 

- 

- 

How to send 

1 From the [FAX Transmission Popup] screen, select [Fax Mode Setting Details...]. 

The [Fax Mode Details] screen opens. 

2 Specify the recipient's Confidential User Box. 

→  [SUB Address]: Enter the Confidential User Box number of the recipient. 

→  [Sender ID]: Enter the password for the recipient's Confidential User Box. 

3 Click [OK]. 
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5.4 Sending a Fax via Relay Station (Relay Distribution) 

5.4 Sending a Fax via Relay Station (Relay Distribution) 

Relay distribution 

The Relay Distribution function distributes a fax to the preset recipients using relay stations. 

If you have grouped the relay stations and recipients by area, you can reduce the total communication cost 

than the broadcasting of fax to all destinations. This is useful for broadcasting to distant locations. 

Tips 

The destination machine (the relay station) must have the F-code function. 

When using the relay distribution, you need to check both the number of the Relay User Box defined 

for the relay station and the password. 

- 

- 

How to send 

1 From the [FAX Transmission Popup] screen, select [Fax Mode Setting Details...]. 

The [Fax Mode Details] screen opens. 

2 Specify the recipient's Relay User Box. 

→  [SUB Address]: Enter the Relay User Box number of the recipient. 

→  [Sender ID]: Enter the password for the recipient's Relay User Box. 

3 Click [OK]. 
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5.5 Send a Fax with Authentication Information 

5.5 Send a Fax with Authentication Information 

Fax transmission for authentication setup 

If user authentication and account track have already been employed, each user needs to send his/her au- 

thentication information (the user name and password) to this machine when sending PC-Fax. This limits the 

users who can send PC-Fax via the machine and prevents unauthorized use by third parties. 

When this machine receives a send job from a user who is not authorized to use this machine, or when this 

machine receives a send job that does not have any authentication information, this machine discards these 

jobs automatically. 

Tips 

A send job that does not have any authentication information refers to a job whose user authentication 

or account track has not been set correctly in the [Configure] tab in the [Properties] screen of the fax 

driver. 

- 

Operations required to use this function 

Open the [Configure] tab of the fax driver, and ensure that the user authentication or account track has been 

set correctly. 

1 Open the [Properties] screen of the fax driver. 

→  For details on how to open the [Properties] screen, refer to page 6-2. 

2 Open the [Configure] tab, and check the [Device Option] to ensure that the user authentication or ac- 

count track has been set correctly according to the current operating environment. 

→  If it is not configured correctly, select [User Authentication] or [Account Track] from the list, then 

change the relevant setting in [Setting]. 

3 Click [OK]. 
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5.5 Send a Fax with Authentication Information 

How to send 

1 In the [Basic] tab, click [Authentication/Account Track...]. 

2 When user authentication is enabled, select [Recipient User], then enter the user name and password. 

→ If access to this machine by public users (unregistered users) is allowed, you can select [Public User] 

and send a fax without entering the user name and password. 

When using an external authentication server, click [Server Setting...] and select the authentication 

server. 

→ 

→ If you always use the same user name and password, registering them in advance eliminates the 

need for entering them each time. For details, refer to page 2-7. 

3 If account track is enabled, enter the account name and password. 

→  If you always use the same account name and password, registering them in advance eliminates 

the need for entering them each time. For details, refer to page 2-7. 
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5.5 Send a Fax with Authentication Information 

4 Click [OK]. 

→  If the PC can communicate with this machine, you can click [Verify] to check the entered authenti- 

cation information. Also, you can check the authentication information for errors before printing it. 

5 To perform MFP authentication when external server authentication is used together, select the [MFP 

Authentication] check box in the [Other] tab. 

6 Send a fax. 

If the authentication information is correct, the fax is sent. 
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6.1 The [Properties] Screen of the Fax Driver 

6 Fax Driver Settings 

6.1 The [Properties] Screen of the Fax Driver 

How to display the [Properties] window 

The fax driver has two screens for configuring settings: the [Properties] screen and the [Printing Preferences] 

screen. The following explains the [Properties] screen. 

In the [Properties] screen, you can set the optional environment of this machine and Windows OS functions. 

You can open the [Properties] screen as follows. 
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6.1 The [Properties] Screen of the Fax Driver 

1 Display the printer window. 

→ In Windows 8.1, click [ ]in the Start window, then click [Control Panel] - [Hardware and Sound] - 

[View devices and printers]. 

In Windows 8, right-click the Start window, then click [All apps] - [Control Panel] - [Hardware and 

Sound] - [View devices and printers]. 

→ 

→ In Windows Server 2012/Server 2012 R2, open the Start window, then click [Control Panel] - [Hard- 

ware] - [View devices and printers]. 

→ In Windows 7/Server 2008 R2, click the Start menu, then click [Devices and Printers]. 

If Devices and Printers is not displayed, click [Control Panel] - [Hardware and Sound], then click 

[View devices and printers]. 

→ In Windows Vista/Server 2008, click the Start menu, then click [Control Panel] - [Hardware and 

Sound] - [Printers]. 

When [Control Panel] is displayed in Classic View, double-click [Printers]. 
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6.1 The [Properties] Screen of the Fax Driver 

→ In Windows Server 2003, click the Start menu, then click [Printers and Faxes]. 

If [Printers and Faxes] is not displayed, click [Control Panel] - [Printers and Other Hardware] - [Print- 

ers and Faxes]. When [Control Panel] is displayed in Classic View, double-click [Printers]. 
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6.1 The [Properties] Screen of the Fax Driver 

2 Open the printer properties. 

→ In Windows 7/8/8.1/Server 2008 R2/Server 2012/Server 2012 R2, right-click the icon of the installed 

printer, and from [Printer Properties], click the displayed printer name. 

→ In Windows Vista/Server 2003/Server 2008, right-click the icon of the installed printer, then click 

[Properties]. 

The [Properties] screen appears. 

Tabs provided by Windows 

The [General], [Sharing], [Port], [Advanced], [Color Management], and [Security] tabs are provided by Win- 

dows. 

You can print a test page, configure printer sharing, configure printer ports, etc. For details, refer to the Win- 

dows manuals. 
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6.2 Available Operations with the [Configure] Tab 

6.2 Available Operations with the [Configure] Tab 

In the [Configure] tab, you can register a method to obtain information about the installation status of optional 

devices on this machine as well as the information about this machine in the fax driver. 

Tips 

When [Auto] in [Obtain Settings...] is enabled and the computer is unable to communicate with this ma- 

chine, the computer takes a long time to display the [Properties] screen or the [Printing Preferences] 

screen. 

If you are using the machine from a Windows Server 2003 PC via USB connection, [Obtain Device In- 

formation] cannot be used. 

- 

- 

Related setting (for the administrator) 
You can use a password to restrict the ability to obtain device information from the printer driver (de- 

fault: [No]). For details, refer to "User's Guide[Descriptions of Functions/Utility Keys]/[Utility]". 

- 
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Settings Description 

[Device Option] 
 

The model name, options installed on this machine, and authentication set- 
tings of this machine are displayed. 
When the settings of this machine cannot be obtained, you need to manually 
change the settings. Select an item to change from the list, and set a value in 
the [Setting]. 

[Obtain Device Informa- 
tion] 

 

The PC communicates with this machine and obtains the optional device in- 
stallation information. 
In [Obtain Settings...], set the method of obtaining the information on this ma- 
chine. 

[Obtain Settings...] Configure the settings to obtain the information of this machine. 

 [Auto] Select this check box to automatically obtain the information of this machine. 

[Destina- 
tion Set- 
tings] 

 

Set the communication method to use to obtain information from this machine. 
• [Device which Connect with Printer Port]: Information is obtained from the 

printing port specified in the [Port] tab in the fax driver. 
• [Specify IP Address or Printer Name]: Information is obtained by connect- 

ing to a device with the entered IP address or printer name. 

[Read 
Commu- 
nity 
Name] 

Enter the Read Community Name used to obtain information from this machine 
if you have changed the SNMP Read Community Name on this machine. 

 

[Enter 
Pass- 
word to 
acquire 
Device In- 
formation] 

Enter the password for user authentication if the device information is pass- 
word protected against access through the fax driver on this machine. 

 

[Encryption 
Passphrase] 

 

Select this check box to set a unique encryption passphrase. 
The encryption passphrase is used to cipher the authentication password 
when it is sent to this machine during fax transmission. Normally, the authen- 
tication password is encrypted using the encryption passphrase registered in 
advance in this machine. However, you can change the encryption passphrase 
when necessary. 
To change the encryption passphrase, change the settings of this machine, 
then enter the preset encryption passphrase for the fax driver. For details on 
how to change the encryption passphrase, refer to "User's Guide[Print Opera- 
tions]/[Printing in the Windows Environment]". 
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6.3 Available Operations with the [Settings] Tab 

6.3 Available Operations with the [Settings] Tab 

In the [Settings] tab, you can change the default settings for how confirmation messages are displayed as 

well as the screen for inputting authentication information. 

Settings Description 

[Display Constraint 
Message] 

Select this check box to display a message indicating that you have selected 
the fax driver functions that cannot be used together. 

[Display paper set in 
Print Server Properties] 

Select this check box when using the paper added in [Server Properties] in the 
printer screen. 

[Reconfirm FAX number 
entered directly] 

Select this check box if you enter the [FAX Number] directly in the [FAX Trans- 
mission Popup] screen and if you wish to confirm the fax number in the screen 
when you click [Add Recipients]. 
This is helpful to prevent a fax from being sent to an incorrect destination. 

[Authentication Set- 
tings...] 

Configure the User Authentication/Account Track settings. 
• [Verify Authentication settings before printing]: Select this check box to en- 

able the [Verify] button in the [Authentication/Account Track] dialog box. 
[Popup Authentication Dialog when printing]: Select this check box to dis- 
play the [Authentication/Account Track] dialog box when starting printing. 
This option reminds you to enter the user name and password. 
[Do not allow changes to the [User Name]]: This option restricts changes to 
[User Name] of [Recipient User] in the [Authentication/Account Track] dia- 
log box in the [Basic] tab. 
[Do not allow changes to the [Password]]: This option restricts changes to 
[Password] of [Recipient User] in the [Authentication/Account Track] dialog 
box in the [Basic] tab. 

• 

• 

• 

[Wake-On-Lan Set- 
tings...] 

Configure a setting for the Wake-On-Lan function. 
The setting on the machine side is required in advance to use the Wake-On- 
Lan function. How to configure the setting is explained using Web Connec- 
tion. For details, refer to "User's Guide[Web Management Tool]/[Managing the 
Machine Status]". 
• [Awake before print from Power Saving Mode]: Select this check box to re- 

turn to the normal mode before sending a print job when the machine is set 
to the ErP Auto Power Off mode. 

• [MAC Address]: In the administrator mode of Web Connection, select 
[Network] - [Extended Network Settings] - [Device Setting], then enter the 
MAC address that is displayed. 

[Save Custom Size...] When you send a document having the special size, select the size and register 
its papers. 
The registered paper size can be selected from [Original Size] or [Paper Size] 
of the [Basic] tab. 

[Setting Up LDAP...] If you are using the LDAP server or the Active Directory of Windows Server, you 
can register a server to search for recipients. The registered server is displayed 
in the Phone Book. 
For details on how to register it, refer to page 6-9. 

Tips 

You can open the [Server Properties] screen as follows. 

In Windows 7/8/8.1/Server 2008 R2/Server 2012/Server 2012 R2, select a printer, and click [Print Serv- 

er Properties] on the toolbar. 

In Windows Vista/Server 2008, right-click on the area that has nothing displayed in the [Printers] win- 

dow, and click [Run as administrator] - [Server Properties]. 

In Windows Server 2003, click the [File] menu, and click [Server Properties]. 

You can set the following types of papers in the Server Properties of the fax driver. 

Custom sizes available in fax driver: 

Width: 3-9/16 to 11-11/16 inches (90.0 to 297.0 mm), Length: 5-1/2 to 17 inches (139.7 to 431.8 mm) 

Allowable range of large size 1: 

Width: 11-11/16 to 33-1/8 inches (297.1 to 841.0 mm), Length: 5-1/2 to 46-13/16 inches (139.7 to 

1189.0 mm) 

Allowable range of large size 2: 

Width: 3-9/16 to 11-11/16 inches (90.0 to 297.0 mm), Length: 17 to 46-13/16 inches (431.9 to 

1189.0 mm) 

The paper sizes registered in the range of the above custom sizes are available in both [Original Size] 

- 

- 
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6.3 Available Operations with the [Settings] Tab 

and [Paper Size] of the fax driver. However, the paper size registered in the allowable range of each 

large size is available only in [Original Size] of the fax driver. 
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6.4 Register an LDAP Server in the Fax Driver 

6.4 Register an LDAP Server in the Fax Driver 

If you are using the LDAP server or the Active Directory of Windows Server, you can register a server on the 

fax driver and you can search for a recipient on the server. 

The following explains the server registration procedure in the fax driver. 

1 Open the [Properties] screen of the fax driver. 

→  For details on how to open the [Properties] screen, refer to page 6-2. 

2 Open the [Settings] tab, and select [Setting Up LDAP...]. 
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6.4 Register an LDAP Server in the Fax Driver 

3 Click [Add] and enter the LDAP server information, then click [OK]. 

⊙Reference 
For details on the destination search using LDAP server, refer to page 4-7. 
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Settings Description 

[LDAP Server List] 
 

Lists the already registered LDAP servers. 
• [Up]/[Down]: Moves the display position of the selected LDAP server. 
• [Delete]: Deletes the selected LDAP server. 

[Server Address] Enter the LDAP server address. 

[LDAP Server Name] 
 

Enter an LDAP server name to be displayed in the [LDAP Server List]. 
Use names that can easily identify the servers. 

[Connection] tab Sets an authentication type and the port for connection to the LDAP server. 

 [Authen- 
tication 
Type] 

 

Select the authentication type to log in the LDAP server. 
Select the authentication type according to the LDAP server you are using. 
If you have selected an option other than [Anonymous], enter the authentication 
information. 

[Port Set- 
tings] 

 

Change the connection port number of the LDAP server if necessary. 
Usually, you can use the default settings. 
Select the [Use SSL] check box to use the SSL communication. 

[Search] tab 
 

Set the search base and communication timeout when you use the LDAP 
search. 

 [Time- 
out(Sec- 
ond)] 

Change the timeout time of communication with LDAP server if necessary. 
 

[Max.Sea 
rch Re- 
sults] 

Change the maximum number of destinations to be displayed as search results 
if necessary. 

 

[Search 
Base] 

Specify the starting point when searching for a destination. 
 

[Search Attributes] tab 
 

When you use the LDAP search, enter the attributes for the name, family name, 
given name, fax number, E-mail address, company name, and organization 
name. 
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6.5 The [Printing Preferences] Screen of the Fax Driver 

6.5 The [Printing Preferences] Screen of the Fax Driver 

The following explains the [Printing Preferences] screen. 

The fax driver has two screens for configuring settings: the [Properties] screen and the [Printing Preferences] 

screen. This section describes the [Printing Preferences] window. 

The [Printing Preferences] window has multiple tabs on each of which related functions are grouped to enable 

you to configure print functions unique to this machine. To display the [Printing Preferences] window, take 

the following steps: 
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6.5 The [Printing Preferences] Screen of the Fax Driver 

1 Display the printer window. 

→ In Windows 8.1, click [ ]in the Start window, then click [Control Panel] - [Hardware and Sound] - 

[View devices and printers]. 

In Windows 8, right-click the Start window, then click [All apps] - [Control Panel] - [Hardware and 

Sound] - [View devices and printers]. 

→ 

→ In Windows Server 2012/Server 2012 R2, open the Start window, then click [Control Panel] - [Hard- 

ware] - [View devices and printers]. 

→ In Windows 7/Server 2008 R2, click the Start menu, then click [Devices and Printers]. 

If [Devices and Printers] is not displayed, click [Control Panel] - [Hardware and Sound], then click 

[View devices and printers]. 

→ In Windows Vista/Server 2008, click the Start menu, then click [Control Panel] - [Hardware and 

Sound] - [Printers]. 

When [Control Panel] is displayed in Classic View, double-click [Printers]. 
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6.5 The [Printing Preferences] Screen of the Fax Driver 

→ In Windows Server 2003, click the Start menu, then click [Printers and Faxes]. 

If [Printers and Faxes] is not displayed, click [Control Panel] - [Printers and Other Hardware] - [Print- 

ers and Faxes]. When [Control Panel] is displayed in Classic View, double-click [Printers]. 
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6.5 The [Printing Preferences] Screen of the Fax Driver 

2 Open [Printing Preferences]. 

→ In Windows 7/8/8.1/Server 2008 R2/Server 2012/Server 2012 R2, right-click the icon of the installed 

printer, and from [Printing Preferences], click the displayed printer name. 

→ In Windows Vista/Server 2003/Server 2008, right-click the icon of the installed printer, and click 

[Printing Preferences...]. 

The [Printing Preferences] screen is opened. 

Tips 

The print settings changed here are registered as default values. To temporarily change settings when 

performing PC-FAX TX from the application software, click [Properties] (or [Preferences]) in the [Print] 

screen to open the [Printing Preferences] screen. 

- 

Items common to each tab 

The following explains the commonly used settings and buttons in each tab. 

Settings Description 

[Favorite Setting] You can register the current print settings as a favorite and recall it when send- 
ing a fax. 
For details on the [Favorite Setting], refer to page 4-10. 

View Displays the page layout sample with the current settings so that you can 
check the transmission fax image. 
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6.5 The [Printing Preferences] Screen of the Fax Driver 

Settings Description 

[Printer Information] Click this button to start Web Connection and check the printer information. 
This button is enabled only when your computer can communicate with this 
machine. 

[OK] Applies the changes made to the settings and closes the setting window. 

[Cancel] Discards (or cancels) the current changes and closes the setup window. 

[Help] Displays the help for each item in the window. 

[Default] Reverts the settings to their default values. 
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6.6 Available Operations with the [Fax] Tab 

6.6 Available Operations with the [Fax] Tab 

Various fax transmission options can be set in the [FAX] tab. 

Settings Description 

[Resolution] Set a resolution to send a fax. If the resolution is high, a large amount of infor- 
mation is scanned and the communication time increases. 

[Print Recipient File] Select this check box to send a fax and print it at the same time. 
You can also set this option in the [Fax Mode Setting Details...] of [FAX Trans- 
mission Popup] screen. 

[Timer Send] Select this check box to set a time to send a fax. The fax is automatically sent 
at the specified time. 
• [Reflect Current Time]: Reflects the current time of the PC onto the [Send 

Time]. 
You can also set this option in the [Fax Mode Setting Details...] of [FAX Trans- 
mission Popup] screen. 

[SUB Address] When you use the F-code TX function, enter the box number for the destination 
box (using up to 20 digits). 
You can also set this option in the [Fax Mode Setting Details...] of [FAX Trans- 
mission Popup] screen. 

[Sender ID] When you use the F-code TX function, enter the password for the destination 
box (using up to 20 digits, with available symbols being # and *). 
You can also set this option in the [Fax Mode Setting Details...] of [FAX Trans- 
mission Popup] screen. 

[Cover Sheet] Select this check box to add a cover sheet to the fax when you send it. Click 
the [Settings...] button to set up the cover sheet details. 
You can also set this option in the [FAX Cover Sheet] of [FAX Transmission 
Popup] screen. 

[Phone Book Entry...] Click this button to edit phone books. 
For details, refer to page 4-12. 

Tips 

When you use the timer transmission, check that the clock time of the PC matches the clock time of 

this machine. If the clock time of this machine has already passed the specified send time, the fax is 

sent in the next day. 

- 
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6.7 Available Operations with the [Basic] Tab 

6.7 Available Operations with the [Basic] Tab 

In the [Basic] tab, you can set the original orientation and paper size. If user authentication or account track 

is employed on this machine, set the authentication information. 

Settings Description 

[Original Orientation] Specify the orientation of the original created in application software. 
If the setting in the fax driver differs from that specified in the application soft- 
ware, correct the setting. 

[Original Size] Select the size of the original created in application software. 
If the setting in the fax driver differs from that specified in the application soft- 
ware, correct the setting. 
When scanning a custom-sized original, select [Custom Size] and set its width 
and length. 

[Paper Size] Select a paper size of send a fax. 
If this setting differs from the original size and [Zoom] is set to [Auto], the orig- 
inal is enlarged or reduced to the selected paper size. 
When sending a custom-sized document, select [Custom Size] and set its 
width and length. 

[Zoom] Select how the print image is enlarged or reduced. 
• [Auto]: The image is enlarged or reduced to the size specified in [Paper 

Size]. 
• [Manual]: The image is enlarged or reduced by the specified ratio (25 to 

400%). 

[Authentication/Ac- 
count Track...] 

When user authentication or account track is employed, enter the user name 
or account name and the password. For details, refer to page 5-8. 

Tips 

The large size registered in Print Server Properties is also reduced to the size specified in [Paper Size]. 

The paper set in Print Server Properties is available when the [Settings] check box is selected in the 

[Display paper set in Print Server Properties] tab. 

Custom size documents may be reduced and printed on standard A4 size papers by the destination 

machine due to its limited performance. 

- 

- 
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6.8 Available Operations with the [Layout] Tab 

6.8 Available Operations with the [Layout] Tab 

In the [Layout] tab, you can configure layout settings for fax sending. 

Settings Description 

[Combination] Select how the original pages are combined on sheets. 
•  [2 in 1]/[4 in 1]/[6 in 1]/[9 in 1]/[16 in 1]: 

Multiple pages are reduced on the same side of one sheet for sending. For 
example, when you select [9 in 1], every set of nine pages is reduced on the 
same side of one sheet for sending. 

•   [2 x 2]/[3 x 3]/[4 x 4]: 
The original image is enlarged, divided and printed onto multiple sheets. 
For example, when you select [2 x 2], one page of the original is divided and 
printed onto four sheets. When you join the printed sheets, you will create 
a large poster. 

As necessary, click [Combination Details... ]to configure detailed settings 
about page combination. 
• 
• 

[Combination]: Select the page combination. 
[Layout Order]: When you have selected N in 1 in [Combination], select the 
order of pages in the layout. 
[Border]: When you have specified N in 1 in [Combination], select this 
check box if you want to draw border lines between pages. In addition, se- 
lect the type of border lines. 
[Overlap width line]: When you have specified N e N in [Combination], se- 
lect this check box if you want to create overlap margins. 

• 

• 

[Skip Blank Pages] Select this check box to exclude blank pages in the original from the pages to 
be send. 
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6.9 Available Operations with the [Stamp/Composition] Tab 

6.9 Available Operations with the [Stamp/Composition] Tab 

In the [Stamp/Composition] tab, you can set the composition of the watermark on the original. 

Settings Description 

[Watermark] Select this check box to print a watermark (text stamp) on the original. Also, 
select a watermark for composition from the list. 
Click [Edit...] and you can enter and edit a watermark. For details, refer to "Us- 
er's Guide[Print Operations]/[Printing in the Windows Environment]". 
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6.10 Available Operations with the [Quality] Tab 

6.10 Available Operations with the [Quality] Tab 

In the [Quality] tab, you can set a font process on the original when it is sent by fax. 

Settings Description 

[Font Settings] Specify how to process texts. 
Select the type (bitmap or outline) of the fonts to be downloaded from the com- 
puter to this machine. Also specify whether to replace the TrueType fonts by 
printer fonts when sending by fax. 
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6.11 Available Operations in the [Other] Tab 

6.11 Available Operations in the [Other] Tab 

In the [Other] tab, you can check the driver version and other information. 

Settings Description 

[MFP Authentication] Select this check box to log in using the MFP authentication function when 
both MFP authentication and server authentication are used for user authenti- 
cation. 
This option is available when [Device Option] - [User Authentication] in the 
[Configure] tab is set to [ON (MFP) + ON (External Server)] or [ON (MFP) + ON 
(Enhanced Server)]. 

[About] The version of the fax driver is displayed. 
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6.11 Available Operations in the [Other] Tab 
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Delete the Fax Driver 
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7 Delete the Fax Driver 

Uninstall the fax driver software using the delete program 

If you have installed the fax driver using the installer, the fax driver uninstallation function has been added to 

the driver. 

◎ 

1 

You need to have the administrator privileges to perform this task. 

Start the deletion program. 

→ From the Start menu, click [All Programs] (or [Programs]) - [SINDOH] - [N500 Series (PS_PCL_FAX)]  

- [Uninstall Printer Driver]. 

In Windows 8.1, click [ ]in the Start window, select [Control Panel] - [Programs], then click [Uninstall 

a program]. In the list, double-click [SINDOH N500 Series (PS_PCL_FAX)]. 

In Windows 8, right-click the Start window, select [All apps] - [Control Panel] - [Programs], then click 

[Uninstall a program]. In the list, double-click [SINDOH N500 Series (PS_PCL_FAX)]. 

In Windows Server 2012/Server 2012 R2, open the Start window, then click [Control Panel] - 

[Programs] - [Uninstall a program]. In the list, double-click [SINDOH N500 Series (PS_PCL_FAX)]. 

→ 

→ 

→ 

2 Select the fax driver you wish to delete, then click [Uninstall]. 

→  Follow the subsequent on-screen instructions. 

3 If the dialog box prompting to restart the computer appears, click [OK]. 

Now, the fax driver has been deleted. 

Delete the fax driver using the installer 

If you have installed the fax driver using the installer, you can use the installer to delete the fax driver. 

◎ You need to have the administrator privileges to perform this task. 

1 Insert the printer driver CD-ROM into the CD-ROM drive of the computer. 

→  Make sure that the installer starts, and then go to Step 2. 

→  If the installer does not start, open the printer driver folder on the CD-ROM, double-click [Set- 

up.exe], and then go to Step 3. 

2 Click [Printer Install]. 

The printer driver installer starts. 

3 

4 

Click [AGREE] in the license agreement window. 

Select [Uninstall Printer Driver], then click [Next]. 
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5 Select the fax driver you wish to delete, then click [Uninstall]. 

→  Follow the subsequent on-screen instructions. 

6 If a restart prompt appears, click [OK] to restart the PC. 

Now, the fax driver has been deleted. 

⊙Reference 
For details on how to delete the fax driver manually, refer to "User's Guide[Print Operations]/[Printing in the 

Windows Environment]". 
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